Job Aid

Confirm Purchase Order using File Transfer Method
EN

Use this Supplier portal activity to confirm Purchase Orders via Excel file transfer.

Step Action

1. Upon logging into the SAP SNC system, the Alert Monitor displays.

2. Click the Tools menu.

- il

/6 Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO SRS
—
@L/ @ [z htp: /sapadiso 1.mmm.com:8000, O ¥| [#| 2 supply Network Collaboratio... X T3 9.7 597
| File Edit View Favorites Tools Help
- ~
Alert Monitor Supply Network Collaboration ]
@ HQ‘ E Exceptions Demand Release Purchase Order Replenishment Work Order SNI  Delivery Invoice Qualty Master Data Tools = i
File Transfer Download Center (External User)
Planning Service Manager | Download History (External User)
Supplier Performance Manag! Upload Center (External User)
| Upload History (External User)
Planner: < [u) To ] 4
Customer. 7o | o 4
Supplier: < To | [u)] »
Location: & [a] To [a)] 4
My Location: < ol To [ [} >
product < [ 7o [ o &
My ProductNo.: < | 9] 7o [ [u] 4
ApnType: O[O >
apn: O | a7 [ ol »
Product Group Type: < | [a] L4
Statistical View
Reset to Default
Grouping Criteria 1: [ Alert Type (Long) ~| Grouping Criteria 2: | ~ | Grouping Criteria 3: | ~ | Display Alerts By: [Ald
v
< >
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Step Action
3. Click the Download Center (External User) menu item.
Download Center (External User)
4, The first time you use the Download Center (External User) screen, create a download
profile.
In the future, having a pre-defined download profile saves time when generating the PO
confirmations download file.
In this example, create a Download Profile that only defines the customer. In the live
system you have the option of creating multiple Download Profiles with additional search
criteria.
B
@A ® [z htp: 7sapgiso 1.mmm.com:5000, O[] [#2] =7 Supply Network Collaboratio... xI_I AL
| File Edit View Favorites Tools Help i
Download Center (External User) Supply Network Collaboration Business Partner: 2
S 1 B8 | Exceptions Demand Release PurchaseOrder Replenishment WorkOrder SNI Defvery lInvoice Quaity Master Data Hoolg
\L::\IN ?T;r\ells:vD 1:;12812015 13:42:4:}@
Download Profiles Overview
Generate Download File View Log History | | Create| Modify Deactivate View: [[Standard View] || PrintVersion Exports ¥ &
Ty | Download Profile Type Profile Number | Profile Name Profile Status | URL for Download Downloaded On Ready On Initiated On | User Name |
Due List for Purchasing Documents 431 Click here to downioad 13:33:35 0 13:33:29 13:33:24 27277777
< >
Step Action
5. Click Create.
Create
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€ supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by SH/IE100GP0__ I8/
@' [ it /s3pgeiso .mmm.com:2000, O[] 42 |7 sipply Network Colaboratio... X |_| (0} 29§23
| File Edit View Favorites Tools Help
Download Center (External User) Supply Network Collaboration Business Partner
S 2] Exceptions Demand Release Purchase Order Replenishment Work Order SNI  Delivery Invoice Qualty MasterData Tools
» 1 2 3 4 »
Choose Partner Choose Profile Type Specify Selection Criteria Define Periodicity
Supplier: * |1610025
Customer: *
Supplier User: * | ZZzzzzZ
[<_Previus | [Mext 3] [Fiish | [Ganesl]
Step Action
6. Click the Customer: field.
7. Type Customer: * "CORP_3M".
8. Click Next.
| Next »
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6 supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by SH/IE100GPO_ SEIE]
@:;v[:' http: /sapgdl50 1.mmm.com:8000, JO 7] [ 42 || =7 supply Network Collaboratio... xl__l e
| Fle Edit View Favorites Tools Help
Download Center (External User) Supply Network Collaboration Business Partner
EE=pa 2] Exceptions Demand Release Purchase Order Replenishment Work Order SNI  Delivery Invoice Qualty MasterData Tools
» Kl 2 3 4 »
Choose Partner Choose Profile Type Specify Selection Criteria Define Periodicity
Profile Type [Due List for Purchasing Documents |
Step Action
9. Click the button to the right of the Profile Type field.
-
10. Click Purchase Order Confirmation.
| Purchase Order Confirmation
11. Click Next.
| Next b
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@j » [z hip Lmmm.com:3000, O 7] |2 =7 supply Network Collaboratio... X |_J
| Fie Edit View Favorites Tools Help
Download Center (External User) Supply Network Collaboration
& ZD B | exceptions Demand  Release  Purchase Order Replenishment WorkOrder SNI  Delivery Invoice Qualty Master Data
» KR 77 3| 3! »
Choose Partner Choose Profile Type Specify Selection Criteria Define Periodicity
PONo: O | [u] o =
customerloc: @[ [ To [ g 4
My Loc. No.: @ o 4
shipfromtoc: @[ & To L2
MySFlocho: @[ [ To [ 4
sipTotoc: @[ A L3 I = | 4
MySTlocNo: @[ [ To [ [u] L4
product: © | )70 [ fa]l-4
My ProductNo: < | 7o [ =]l
ProductGroupType: | (3|
PoductGroup: @[ [ LCY R - ) 4
APN Type: =]
aen: O | 7o [ g ®
SNCPlanner: | O3]
DefveryDate: @[ @ To [ [16] 4
Shipping Date: O L I ] 4
Goods Recipient: < a To fa] 4
e I n[a >
Confirmation Status: »
puchGop: @[ [ O3 I - ) 4
orderTypec: O [ o[ O >

Business Partner

Tools

Step

Action

12.

Click Next.

13.

If you want to set the profile to run automatically, select the frequency from the
Periodicity of File Generation list.
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@:"b’ http://sapqdl0 .mmm.com:000, O =] 42| |25 upply Network Collaboratio. X|___| {0t 29 523
| Fle Edit View Favorites Tools Help
Download Center (External User) Supply Network Collaboration Business Partner
Ea=pa [B® | Exceptions Demand Release PurchaseOrder Replenishment WorkOrder SNI Deivery Invoice Quaity MasterData Tools
» 1 [7 37 4 »
Choose Partner Choose Profile Type Specify Selection Criteria Define Periodicity
icity of File ion [No Periodic Job |
Step Action
14. Click Next.
Fliext b
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/E Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO

v [z hip . P 21 142] = Supply Network coliaboratio... X

mmm. com: 5

| File Edit View Favorites Tools Help

@E,]QHE Exceptions Demand Release Purchase Order Replenishment Work Order SNI Delivery Invoice Qualty Master Data Tools
“ | p— |
Initiate File Generation

Delivery Type of File * [Pick Up in Download Center ~

E-Mail Address | mmmmm@mmm com

Immediate File Generation (V]

[ Previous] [ e

Download Center (External User) Supply Network Collaboration Business Partner
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Step

Action

15.

Click the Profile Name field.
I

16.

Type Profile Name "JADLO001".

17.

You have the option to set the Delivery Type of Download File to be either picked up
from the Download Center (External User) or emailed to you.

18.

Click Finish.
[ Finish

19.

After creating the Download Profile, generate the Purchase Order Confirmation file and
download it to your computer.

/E Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO -[&] x|
—
@ €)% [= hito:/1sapods0 L. mmm.com:000, O =] {42 =7 ity Network Coloboratio.. X {0} 97 593
| Fle Edit View Favorites Tools Help
~
Download Center (External User) Supply Network Collaboration Business Partner ]
S [ | Exceptions Demand Release PurchaseOrder Replenishment WorkOrder SNI Deivery Invoice Quaity MasterData Tools
File generation for profile JADL001 scheduled for immediate execution
Display Message Log
Last Refresh: 04/28/2015 13:49:52
View: [Own Data ~]
Download Profiles Overview
| Generate Download File View Log History | Create Modify Deactivate View: [[Standard View] v]|| Printversion Exports B &
T Download Profile Type Profile Number | Profile Name Profile Status | URL for Download Downloaded On Ready On Initiated On | User Name | |
Due List for Purchasing Documents | 431 15AStringTest = Downloaded = Click here to download | 04/28/2015 13:33:35 | 04/28/2015 13:33:29 | 04/28/2015 13:33:24 | ZZZ7777
| Purchase Order Confirmation a2 JADLODY New Zzz2772
v
< >

Step

Action

20.

Click Refresh.
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—
@ @ [z hitp: jsapadiso 1.mmm.com:3000, O 7] | #2| 27 supply Network Collaboration., X {h 2.0 §93
| File Edit View Favorites Tools Help
~
Download Center (External User) Supply Network Collaboration Business Partner M
|
IO 25 [ | Exceptions Demand Release PurchaseOrder Replenishment WorkOrder SNI Deivery Invoice Quaity MasterData Tools
Last Refresh: 04/28/2015 13:49:57 Hefresh
View: [Own Data -
Download Profiles Overview |
| Generate Download File View Log History | Create Modify Deactivate View: |[Standard View] v|| PprintVersion Exports ¥ & ‘
3| Download Profile Type Profile Number | Profile Name | Profile Status | URL for Download Downloaded On Ready On Inttiated On | User Name | |
: Due List for Purchasing Documents | 431 1 tringTest | D Click here to download | 04/28/2015 13:33:35 | 04/28/2015 13:33:29 | 04/28/2015 13:33:24 | ZZZZ777
'7 Purchase Order Confirmation 472 JADLOO1 Ready here 1o g ad 042812015 13:49:53  04/28/2015 13:49:52 ZZZZ777
v
< >

21.

Click Click here to download.

22.

Click Open.

E=NE

23.

The Excel file with the list of Purchase Orders displays. Review the POs and make any
changes necessary.

*Go to the Confirm Components Using File Transfer Method section in this document
for Subcon PO — Component Confirmation.

In this example, change the delivery date.
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BE S s CORP_3M_POCONF_20150428184952.csv - Excel ? B - 8 X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW QUICKHELP Get Started ] *
o, v | = v &= - -
B % P T Casl== o |% |[Goea FZ Conditional Formatting E Insert E QY H
o Ep - = [% Format as Table ~ BX Delete ~ [T~ &g
aste = 5 A E o 00 b o in
e BIU- L O-A $% 0 W canstyles- [ Format~ @~ Fiere Select~
Clipboard 1 Font & Alignment & Number [ Styles Cells Editing -~
115 - Jell o v
A B C D E F G H 1 J K E ™M -
Owner Partner:
Partner: CORP_3M
Selection Profile Number: 472

2]

4

5

6 |Created By:
7 |Created On:
8
9

12 ORDER_ID
13 PO No.

CORP_3M_POCONF_20150428184952 ®

Selection Profile Name:  JADLOO1

04/28/2015 18:49:52 CST

ITEM_ID REQUESTE CONFIRMITO_BE_CCREJECT  PRODUCT_ID REV_LEVE QUANTITY QUANTITY DELIVERY_DELIVERY_DELIVERY_SH

PO Item NRequeste: ConfirmecTo Be Con To Be Rej¢ Product RevLvl Quantity UoM Deliv. Dat Deliv.Timi DIvTZ Sh
4800009186 10 X 3010001949 S EA 5/5/2015  0:00:00 CET 5/
4800009186 10 X 3010001949 SIEA 5/5/2015  0:00:00 CET

i ] ey a0,

Step

Action

24,

Click the Deliv. Date field.
5/5/2015

25.

Type the desired information into the box. Type a valid value, e.g., "5/4/2015".
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BEH S s CORP_3M_POCONF_20150428184952,csv - Excel ? @ - 8 X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW QUICKHELP Get Started ] i
AD % |[cambn o can ==Ee- |5 |[Geen -1 & Conditional Formatting - §w1nsen - Ev QY H
Pacie Ea - = g e e [ o w [% Format as Table ~ & Delete ~  [¥]~ TR T
Tey BIUL-H- 0L EE=EEH- 3% B8 Geasyls- [ Format~ @~ Fiere Select~
Clipboard 1 Font ] Alignment ] Number [ Styles Cells Editing ~
K19 - fe v
A B C D E F G H 1 J K E ™M -
1 |Interface Type: POCONF
2 |Owner Partner:
3 |Partner: CORP_3M
4 |Selection Profile Number: 472
5 |Selection Profile Name:  JADLOO1
6 |Created By:
7 |Created On: 04/28/2015 18:49:52 CST
8
9
10
11
12 (ORDER_ID ITEM_ID REQUESTE CONFIRMITO_BE_CCREJECT = PRODUCT_ID REV_LEVE QUANTITY QUANTITY DELIVERY_DELIVERY_DELIVERY_SH
13 |PO No. PO Item NRequestei Confirme(To Be Con To Be Reje Product Revlvl  Quantity UoM Deliv. Dat Deliv.Tim«DIVTZ Sh
14 4800009186 10 X 3010001943 9 EA 5/5/2015  0:00:00 CET 5
15 4800009186 10 X 3010001943 9 EA 5/4/2015  0:00:00 CET
16
17
18
19| 1
20
21
22
23
24
25
CORP_3M_POCONF_20150428184952 ® Ll »

READY H M -——+ 100%

Step Action

26. Click the File tab.
FILE

27. Click Save As.

28. Navigate to a location to save the document and give it an identifiable name.

29. Click Desktop.

30. Type File name: "ULJA001".

31. Click Save as type:.

32. The file must be in a format that the Upload Center (External) accepts.

Save the file as type CSV (Comma delimited) (*.csv).
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x|

Search Desktop

Microsoft Excel :l e =
{1 PO confirm upload file. txt
3 Favorites || Pamlyanna immigration docs summary as of April 20.txt
iy Domionl || TTD as of April 22.txt
B Desktop
@B i oo | TTD as of Apri 09 2015.txt

| Lync Qi Zheng April 13 2015.txt
|| TTTD April 03 2015.txt

"] Recent Places

I Desktop || TTD March 26.txt
(@ Libraries || ZSRMbuyerrespqvSMarch24.txt
5| Documents AME besin oo bk
A music KT |

File name: [ULJA001

Save as type: [Unicode Text (%.txt)
Excel Workbook (. xisx)

Authors: |Excel Macro-Enabled Workbook (*.xism)
Excel Binary Workbook (*.xisb)

Excel 97-2003 Workbook (*.xis) ds
XML Data (*.xml)

Single File Web Page (*.mht; *.mhtmi)
Web Page (.htm; = htmi)

Excel Template (*.xitx)

Options Excel Macro-Enabled Template (*.xitm)
Excel 97-2003 Template (*.xIt)

Text (Tab delimited) (=.txt)

Add-Ins ~ Unicode Text (*. txt)

XML Spreadsheet 2003

= |

inus

elimi
Text (Macintosh) (%.txt)

Text (MS-DOS) (=.txt)

CSV (Macintosh) (%.csv)

CSv (M5-DOS) (*.csv)

DIF (Data Interchange Format) (*.dif)
SYLK (Symbolic Link) (=.sk)

Excel Add-In (*.xlam)

Excel 97-2003 Add-In (*.xla)

PDF (*.pdf)

XPS Document (*.xps)

Strict Open XML Spreadsheet (*.xisx)
|OpenDocument Spreadsheet (*.ods)

Step

Action

33.

Click CSV (Comma delimited) (*.csv).

34.

Click Save.

Save

35.

Click Yes.

36.

Exit Excel and return to the Supply Network Collaboration portal. Navigate to the Upload
Center (External).

37.

Click the Tools menu.
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/6 Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO

JSETES]

—

\ =y hito di501 300 = S Iy 52 o
@\ ¥ [ hitp:jsapgdiso 1.mmm.com:3000, O] 2] =7 Supply Network Collboratio... X IR
| Fle Edit View Favorites Tools Help

~
Download Center (External User) Supply Network Collaboration Business Partner: )
& =P B | Exceptons Demand  Release  Purchase Order  Replenishment  Work Order  SNI Defvery  Invoice Quality Master Data _ Tools
File Transfer >
Last Refresh: 04/28/2015 13:50:02 Refresh Downiged Centor (Ddomal Useo) |
Download History (External User) | Planning Service Manager >
-[OwnbDala ___ ~] |
View: [Own Data =] | Upload Center (ExternalUser) | Supplier Performance Management
Download Profiles Overview ‘ Upload History (External User) |
| Generate Downioad Fie  View Log History | Create Modify Deactivate View: [[Standard View] v|| Printversion Exports W &
| Downioad Profik Type Profile Number | Profie Name | Profile Status | URL for Download Downloaded On | Ready On | Initiated On | User Name |
!: Due List for Purchasing Documents | 431 ing’ Dy Click here to download | 04/28/2015 13:33:35 | 04/28/2015 13:33:29 | 04/28/201513:33:24 | ZZZZ777
r Purchase Order Confirmation 472 JADLOO1 Click here to download 13:50:02 13:49:53 134952 ZZz77777
v
< | ] >

Step

Action

38.

Click Upload Center (External User).
Uplead Center (External User)

39.

To use the Upload Center (External User), you need an upload profile.

In the future, having a pre-defined upload profile saves time when uploading the PO

confirmation information.

In this example, create an upload profile for customer 3M.
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/E Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO

@_\’\/ |z h 150 Lmmm.com:5000, O 7] [ 2] 227 sipply Network Callaboratio... X i %
| File Edit View Favorites Tools Help
Upload Center (External User) Supply Network Collaboration Business Partner:
ﬁ b]* 2 E Exceptions Demand Release Purchase Order Replenishment WorkOrder SNI Delivery Invoice Qualty Master Data
Last Refresh: 04/28/2015 13:41:09 (CST, 0.0 seconds ago) Refresh
View: [Own Data ~]
Upload Profiles Overview
" Upload View Log History | | Create| Modify Deactivate View: [[Standard View] ~|| PrintVersion Exports ¥ &
1| Type | Profie Number | Name Status Posted On | Uploaded On | URL to View Fie Partner | Last Action By

40.

Click Create.
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d@/ £ h:/pgdlml.mm.:sooo, ye

Create Upload Profile

Profile Name: * [

Object type: [Due List for Purchasing
Suppter
Customer:= [ 7]
Suppler User:
FletoUpoass |
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Step Action
41. Click the Profile Name: field.
42. Type Profile Name: "JAUL0002".
43. Click the button to the right of the Object type: field.
44, Click Purchase Order Confirmation.
Purchase Order Confirmation
45, Click the Customer: field.
46. Type Customer: "CORP_3M".
47. Click Browse.
48. Navigate to the file for upload and select it.

2... MicrosoftExcel Com... 4/28/2015 L:SOPM
Microsoft Excel Com... 4/28/2015 1:40 PM
... TextDocument 4/28/2015 1:39 PM
.. Microsoft Excel Com... 4/28/2015 1:36 PM
SRM 0SS 2015.xIsx Microsoft Excel Wor...  4/28/2015 1:09 PM
SNC invoice compariso...  Microsoft Excel Wor... 4/28/2015 1:09 PM
SAP SRM System COm... Microsoft Excel Wor...  4/28/2015 9:40 AM
DP1user auth failure....  GIF image 4/27/2015 5:01PM
SAP SRM System COm... Microsoft Excel Wor... 4/23/2015 4:46 PM
... 04.23 Al Leads Mtg.... Microsoft PowerPoi...  4/23/2015 12:56 PM
STP341_KA.doc Microsoft Word 97 -...  4/23/2015 12:41PM

a22601c s1i0a e
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Step Action
49. Click Open.
m:::::;:: |::j:;ozomrr
Suppter
Customer: =
Supptr ser
Fioto Uposc:
Step Action
50. Click Save.
[Save_
51. Uploading the file may take some time depending upon the size of the file.
Click Refresh to update the Status information.
When the file Status reads "Ready," the file has uploaded.
If the Status is other than ready, troubleshoot the issues and then re-run the upload.
After uploading the file, view the upload log for any errors.
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/6 Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/IE 10.0 GPO

—
@' [ it jsapaaiso .mmm.com:2000, O] 49 |7 sipply Network Colaboratio... X

AR IH

EI

| Fle Edt View Favortes Tools Help

Upload Center (External User) Supply Network Collaboration

& ZH B | exceptions Demand  Release  Purchase Order Replenishment WorkOrder SNI Delivery Invoice Qualty MasterData Tooks

Profile 662 successfully created

Display Message Log

Last Refresh: 04/28/2015 13:41:09 (CST, 0.0 seconds ago) fefres!

View: |Own Data |

Upload Profiles Overview

Business Partner:

| upoad View Log History | {Create! Modify Deactivate View: [[Standard View] ~|| Printverson Exports B & |
T Type Profile Number i Name Status. Posted On Uploaded On | URL to View File Partner Last Action By [
| Purchase Order Confirmation 62 JAULO002  Queued 0412872015 13:53:25  ULIADO1.csv CORP3M 7277777

Step Action

52. Click Refresh.

53. Click View Log.
| View Log

54. The Log displays the message: "File upload job finished for profile number XXXX".
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/5 Supply Network Collaboration (Supplier View) - Windows Internet Explorer provided by 3M/1IE 10.0 GPO
- —_—

Log Display

vew: | Piversin Expots ¥ &
Virus scan profile /SCA/DM_FTRIUPLOAD_FILE is not active for ULJA0O1.csv
Start the processing of virus scan profile /SCA/DM_FTR/UPLOAD_FILE
File upload job started for profile number 662
Processing file ULJA0O1.csv
Item 00010: Confirmation(s) copied to request schedule line(s)
Order : Outbound ing of ReplO ification triggered
0 Purchase orders updated
File upload job finished for profile number 662

EEREREEE

Step Action

55. Click OK.

[ox-

56. You have completed this activity.

End of Procedure.
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Confirm Components Using File Transfer Method

Step Action
1. The steps from the previous section will be followed.
At Step 23, in the Excel file with the list of Purchase Orders, the file will download with
components as displayed in the PO.
The initial POA will not have changes.
Material 7012294182 CLP0B336 5502100 PB LDC
Plant G160 Release Date 09.11.2021
Quantity 100,000 Delvery date 20.12.2021
Component Overview
BL Material Description Requirement Qty U... Q. Plant Pr... Supply Area Regmts date Item 1 Batch Req... B... M.
1010165592 RM-450467 JKLLS .. 108 M 6160 09.11.2021 0010 L 108 M PD
1010139053 RM-248747 BOPP .. 123 M (A 09.11.2021 0020 L 123 M PD
3010133814 Part, Thermoform.. 12 EA 6160 08.11.2021 0100 L 12 EA PD
Components for Schedule Line 1
Accept Reject | View: |[Standard View] ‘H Print Version Export 4
B Component ID Product Qty UoM Appr. Status Notes Cust. Batch Product Desc.
0001 1010165592 108 M 0 RM-450467 JKLL8 1150W
0002 1010139053 123 M 0 RM-248747 BOPP FIML 1160W
0003 3010133814 12 EA 0 Part, Thermoformed Plastic, PLT
ORDER_ID ITEM_ID RECUESTED CONFIRMED TO_BE_CONF PROOL 0 L QUANTITY QUANTITY_UNIT DEUIVERY_DATE DELIVERY VME REC PR CONF_PFCMP_ID CMP_PRODUCT 1D OMP_QUANTITY CMP_CUAN CMP_BATCH IO
PO N, PO item No. Reguasted Confirmed To Be Confirmed Produ i on Quantity UoM Deliv. Date Daliv. Tim Rarquarst Confirme Component ID Product aty UoM Cust. Batch
4512140754 10 x TO1ZIB4182 CLAOSIZE BL SSOMMNZ 100 100 ROL 2002200 C00:00 1 100401 92 108 M
2 10000 39053 mm
3010133814 12 EA
Step Action
2. Once the finished good is produced, a second POA will need to be submitted with actual

component consumption.

The above steps will again be followed and the Excel file with the list of Purchase Orders
will download with components as displayed in the PO.

Review and make the necessary changes.

If components need to be added and/or removed:
Add lines with the new Component ID assignment
Remove lines that are no longer needed

Add relevant batch information for each component.
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Interface Type: POCONF

Owner Partner: 1844294
partner: CORP_3Mm
Selection Profile Number: 923
Selection Profile Name:  Japan Test PAO.
Created By: ABBWQZZ
Created On: 10.11.2021 18:58:21 CST
ORDER_ID Em_D REQUESTED CONFIRMED TO_BE CONF  PRODUCT_ID Z7_VC_DES QUANTITY QUANTITY_UNIT DELIVERY_DATE DELIVERY TIME REQ_PRICONF_PFCMP_ID CMP_PRODUCT_ID CMP_QUANTITY CMP_QUAN CMP_BATCH_ID
PO No. PO Item No. Requested Confirmed ToBe Confirmed Product  VCDescription Quantity VoM Deliv.Date  Deliv.Time  Request Confirme Component ID. Product aty oM Cust, Batch
4812140254 10 X 7012254152 CLP03336 BL SS0MMX2101 100 ROL 2012201 0:00:00 1 1010165552 S0 M \ 1025102825
\ 4 1010165552 M 1025102826
5 1010165552 M 1025102824
Components for Schedule Line 3
Add Components  Delete Components — Create Quality Nofification | View: |[Standard View] [ | Print Version Export 4
B Component ID Product Qty UoM Appr. Status Notes Cust. Batch Product Desc.
1 1010165592 68 M Accepted 0 1025102825 RM-450467 JKLLS 1150W
4 1010165592 20 M Accepted 0 1025102826 RM-450467 JKLLS 1150W
5 1010165592 20 M Accepted 0 1025102824 RM-450467 JKLL8 1150W

Step Action

3. Go to step 26 from the previous section and continue.
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